
Introduction
Welcome to the Codeworks® Tutorial.  By the time you finish this tuto-
rial, you will have a basic understanding of Glyphic Codeworks and
will have built a simple application from scratch.

The application you will be building is a personal Film & Videotape
Database.  The first step will be to construct an object that represents a
film.  It will contain information such as the film’s title, category,
rating, and a description.  As you build the Film object, you will
automatically be building its user interface.  (Conversely, as you build
the user interface for films, you will automatically be building the Film
object!)

Once you have built the Film object, you can create and edit film
entries using the built-in folder browser.  Next, you will build a
customized Film Catalog for the film database.  The Film Catalog will
contain a space to view any film as well as controls for adding &
deleting films and for navigation from one film to another.

Finally, you will add an table of contents to the Film Catalog and
complete the customization process.

Good luck and have fun!
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Tutorial Part I

Creating a new Glyphic Codeworks document

In the instructions that follow,  bulleted items indicate the sequence of
actions you should take, while other text is commentary on those ac-
tions.

• Install Glyphic Codeworks if you haven’t already done so.
• Launch Glyphic Codeworks™.
• Cancel the file chooser dialog.
• Select New from the File menu.
• Select Save As from the File menu.

The list in the upper left of the document contains all of the document’s
folders.  Each folder contains a list of objects.  Most of the folders start
off empty, but if you select a folder, such as the “system classes” folder,
the objects in that folder will appear in the list in the upper right
corner.
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Creating a class

• From the Utilities menu, select New Class....

The ‘class creator’ will open.

• Edit the Class name to read “Film”.
• Set “Make class folder” pop-up choice to “true”.
• Click on  Create & Close.

Notice that the class is automatically added to the user classes folder.
(If the user classes folder is not selected, clock on it to select it.)  In
addition, a new folder named “film folder” is added to the folder list in
the upper left.

A grid appears inside the window for the Film class.  This grid is called
an aligner and will be used to hold the properties that are added to the
class.
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Adding properties to a class

• Command-click in the upper left grid cell of Film.
• Select Insert View... from the pop-up menu.
• Select Label from the pop-up menu.
• Command-click on the new item.
• Select Rename from the pop-up menu to rename it to “Title:”.

In general, you can command-click on any item (or title bar) to bring
up a context specific pop-up menu.

• Command-click in the grid to the right of “Title:”.
• Select Insert View.../String Field from the pop-up menu.
• Rename the new item to “title” as above.

The string field will still have a value of “abc”.  Changing its property
name only changes the name by which it is referenced, not its value.

Note that an existing field can be copied to a new grid location by
dragging the existing field with the command key held down.

• Add a label named “Category:” below “Title:”. 
• To the right of that, insert a string field.
• Rename the property of the new item to “category”. 
• Add a label named “Rating:” and a string field with the proper-

ty name of “rating” to the next row.
• Add a Text Note to the lower right cell of Film.
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Now switch Film from author to user mode and set default values for all
the fields.   The default values are the initial values for new films.

• With the Film window on top, type the escape key.
 

 Notice that in user mode the aligner grid is not drawn.

• Edit the Title to "no title".
• Edit the Category to "-".
• Edit the Rating to "*****".
• Edit the text note to "comments".
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Using a class

Before starting this section, you will probably want to either close Film
to get it out of the way, or drag it so that most of it is off the screen.  If
you do close Film, you can reopen it by selecting “user classes” in the
folder list and then double-clicking on Film in the list in the upper
right.

There should be a folder in the folder list (in the upper left of the
document) named film folder.  If this is not the case, create one now by
command-clicking in the folder list, choosing Create from the pop-up
menu, and entering “film folder” in the resulting dialog.

• Click on the film folder in the folder list.
• Command-click in the film folder’s list (the upper right list).
• Select Create from the resulting pop-up menu.

An instance of the Film class is created and inserted into the film
folder.

• Double-click on the new film.
• Fill in the title, category, and rating and write in the note about

the film if you like.

Add several more films to the film folder.  Notice that all the films have
the same name:  a Film.  It would be nice to change that to something
more descriptive...
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Overriding child-name for Film

The default name for all films is  “a film” (as you can see by looking at
the films in the film folder).  By overriding the child-name property in
Film, you can give its instances more descriptive names.

• Command-click in the title bar of Film.
• Select Override...
• Select "child-name" in the pop-up menu.

A script editor for child-name will appear.  It will already be filled out
with sample text for child-name (including a comment in italics at the
top).  All of that text can be deleted.

• Edit the script for “Film.child-name” so that it reads (including
bolding and punctuation):

return  title && rating.

You can select text and use command-b for bold text, command-p for plain,
command-i for italic, and command-u for strikeout. 

• Click on Save.
• Close the script editor.

The names of the films in the film folder will change to reflect the script
you just wrote.
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Tutorial Intermission
Sprucing up the Film class

In this section, you will make the Category and Rating fields into pop-
up choices.  As the rest of the tutorial does not depend on you doing
this now, you can skip this section and come back to it later.

Make sure that the Film class is open and in author mode.  If it is not
open, click on the user classes folder and then double-click on Film.  If
the alignment grid is not visible that means that the form is in user
mode. Type the escape key to change to author mode.

• Command-click on the category string field.
• Choose View Options... from the pop-up menu.
• Choose View Changer from the pop-up menu.
• Choose pop-up choice view from the View Changer.
• Click on Save & close the View Changer window.

The field will change into a pop-up choice.  Now edit the choices.

• Command-click on the category pop-up choice.
• Choose on Edit Choices from the pop-up menu.

A choice editor for the field will open.

• Remove any existing choices in the list by clicking on them and
then clicking Remove.

• Click on Add and choose “abc”  to insert a string.
• Edit the value (near the bottom of the window)  to “Mystery”.

Add 3 or 4 other film categories like Romance, Comedy, etc.  You  can
click the Test button at any time to see what the menu will look like in
use.  You can change an items position in the list by clicking on it in the
list and then clicking on Up or Down.

You can check that your changes took effect by switching Film to user
mode or by looking at one of the films in the film folder and trying the
pop-up choice.
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Fancy choices

For the Category choices, you used strings for the choices.  For the
Rating choices, you will use one string for the rating itself, and another
to display in the pop-up choice.  Although you could use the same
string for both the rating and the display in the choice, having different
strings allows the choice’s string to be more descriptive while the
ranking itself is terse.

• Double-click on Film in the user classes folder to open it.
• Convert the rating field to a pop-up choice (as in the previous

section) & open its choice editor.
• Delete any items in the choice editor.
• Create 5 titled choices using the Add button.

An titled choice has two properties of interest: a string and a value.  Its
string  is displayed in the pop-up choice.  When a choice is made, the
value is stored into the choice’s property.

• Select a titled choice by clicking on it.
• Change the display title for the  choice to "Must see - 5 stars".
• Change the value for the first entry to "*****".

Edit the string and values for the other 4 entries.  Clicking on any entry
will select it and allow it to be edited.  If inspiration escapes you, you
might use “Great flick! - 4 stars”, “OK - 3 stars”, “Try to avoid - 2
stars”, and “Doggie - 1 star” for the other entries.

Note that you can set the value of a titled choice any value and not just
to strings.  You do this by dragging and dropping the value to the right
of the string field in which you entered the value above.

As in the previous section, you can check that your changes took effect
by switching Film to user mode or by looking at one of the films in the
film folder.
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Tutorial Part II:  The Film Catalog
Creating a customized film folder viewer

In a sense, you have completed a rudimentary Film Catalog.  You can
add, delete, and navigate between  films using the pop-up menu.
However, it would be even better to have a more customized way to
view your film database.

You will create an new object (Film Catalog) for viewing film entries.
The bottom part of Film Catalog will display a single film, the top part
will have controls and status information.

• Close all floating windows except Folders.
• Using the Utilities menu, create a new class named Film

Catalog.

Change the aligner to have 2 rows and 1 column.

• Command-click on the Film Catalog’s aligner.
• Choose View Options... from the pop-up menu.
• Choose Aligner Dimensions from the pop-up menu.
• Change Rows to 2 and Columns to 1.  Click Save & Close.

Add an aligner to the top part of the form to hold the various controls.

• Insert a new aligner  in the upper portion of the aligner.
• Command-click on the new aligner.
• Choose View Options... from the pop-up menu.
• Choose Aligner Dimensions from the pop-up menu.
• Change Rows to 2 Columns to 4.  Click Save & Close.

Add the first control.

• Insert a number field with property name “index” into the
upper left cell of the 2 x 4 aligner.

• Double-click on the number field and set its value from 123 to 1.
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Adding a morph view

Next you will add a morph view to the bottom part of Film Catalog.  A
morph view is a view that can change forms depending on which
object it is viewing.

• Choose  Palette... in the Utilities menu.

The palette contains numerous different fields that can be inserted into
an aligner.  They are described in Glyphic Codeworks Procedures
Manual.

• Drag morph from the Palette to the bottom part of Film Catalog.
Close the Palette.

At this point, the property that the morph view is attached to has the
value of the unknown object.  Change that property to a script
returning the item in the film folder indicated by the index property.

• Command-click in the newly inserted morph field.
• Choose Edit Script from the pop-up menu.
• Edit the script to read:

return  film-folder.list @ index.

• Save and close the script editor.

If you switch Film Catalog to user mode, you will see that changing the
index changes which film is displayed.  Note that the above script does
not handle the error condition in which the index is too big or small.  In
those cases, a debugger will open that you can just close.  A safer script
would read:

if  ((index < 1) or  (index > film-folder.list.size))
then  [ return  ??? ].

return  film-folder.list @ index.
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Adding control buttons to Film Catalog

Now you will add four buttons to the Film Catalog.  Make sure it is in
author mode.

• Add a button to the upper right cell of the 2 x 4 aligner.
• Command-click on the button, choose Rename Control... from

the the pop-up menu.
• Enter the string “Delete” in the resulting note.

Use the same procedure to add a button with the display string of
“New” to the left of the delete button.  Add a button named “<<<“
below New and one named “>>>” below Delete.

Film Catalog should look something like this:
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Writing scripts

The next step is to add scripts to the four buttons that you just added
so that they perform the actions associated with their names.

These tips will be helpful in writing scripts:

• The Templates menu in the script editor’s menu bar can be used
to insert common script fragments (such as the if/then/else
statement).

• The error “Unknown property or local” is often caused by
spelling errors.  You may have have a spelling error in the script
or you may have misspelled the property name when you
added its view.

• Command-B or a selection to make the text bold

• Command-P or a selection to make the text plain.

• Command-I on a word or selection to make the text italic.  (Used
for comments).

• Typing words that begin with a capital letter will be inserted
bold, and in lower case (except in quoted strings). 
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The New Script

Make sure Film Catalog is in author mode before continuing.

• Double-click on the New button.

The script editor named "Film Catalog.script-x" will open.  The script
will already contain sample text.  You can delete all of it.

• Edit its script so that it reads as follows (including all bolding
and punctuation):

$ f.
f := new  film.
film-folder.list insert  f after  index.
index := index + 1.

The first line of the script declares the local variable f.  The next line
creates a new film, by sending the message new to the Film class, and
assigns the new film to f.  The next two lines add f to the film-folder
and increment index.

• Click the Save button of the script editor to save the script.

If there are any errors in the script that prevent it from being saved, the
error message will appear below the text of the Script Editor and the
script’s text that caused the error will be selected.

• Close the Script Editor.

You can switch Film Catalog to user mode and test that the button
works.
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The Delete script

Make sure Film Catalog is in author mode.

• Double-click the Delete button.
• Edit the script so that it reads:

$ size.
size := film-folder.list.size.
if  ((index < 1) or  (index > size)) then  [

tell  user "There are no films to delete.".
return .

] .
film-folder.list delete  index.
if  index > film-folder.list.size then  [

index := index - 1.
] .

First the local variable size is set to the number of films in the film-
folder.  Next, the script checks that the index has an appropriate value
and alerts the user if it does not.  Then the indexed film is deleted.
Finally, the index is decremented if it would have been too large.

• Click the Save button of the script editor to save the script.
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The Previous and Next Scripts

• Edit the script for “<<<“ so that it reads:

index := index - 1.
if  index < 1

then  [ index := film-folder.list.size ].

• Edit the script for “>>>“ so that it reads:

index := index + 1.
if  index > film-folder.list.size

then  [ index := 1 ].
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Tutorial Finale:
Table of Contents & Installation
Creating a table of contents

You have now created a way to view and edit the films in your
database.  However, the ability to see a listing of all the films has been
lost.  To correct this, you will create a new class, named Film Contents,
that displays a list of all the films.  You will change Film Catalog so
that it can display Film Contents, and add a button to turn to Film
Contents.

• Create a new class named Film Contents.
• Change its aligner to be 1 x 1.
• Insert a list into the aligner.
• Edit the script for the list to read:

return  film-folder.list.

The list will display all the films.  Now, change the response clicking
on a film to change the index in Film Catalog to that of the film that is
clicked on.

• Command-click on the list, choose Edit List Commands from
the List section of the pop-up menu.

• Click on the Select menu entry (#6110).
• Click the Edit Script button and override the default script.
• Edit the script to read.

$ item  i, display  d.
film-catalog.index := i.

If you switch Film Contents to user mode, you can use it as is to select
which film should be displayed in the Film Catalog.  The next step,
however, is to integrate Film Contents with the Film Catalog.
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Integrating the table of contents

Next you will change the morph view in Film Catalog so that it
displays Film Contents when the catalog’s index is 0.  Make sure Film
Catalog is in author mode before proceeding.

• Command-click in the morph view in the bottom part of Film
Catalog.

• Select Edit Script from the pop-up menu.
• Edit the script to read:

if  index == 0
then  [ return  film-contents ].

return  film-folder-list @ index.

Now, add a button to Film Catalog to set the index to 0.

• Insert a new button named Contents in the lower left row of the
top aligner in Film Contents.

• Edit the script for the button to read:

index := 0.
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Installing the Film Catalog as the main view

• Close all floating windows except Film Catalog.
• Command-click in Film Catalog’s title bar.
• Select Make Main Win in the View category from the pop-up.

From now on, when you open the document, the Film Catalog will be
displayed.

Congratulations!!

You have  built your first application in Codeworks!   Good luck exper-
imenting with  the environment and building you own custom applica-
tions. 

For more information on building and manipulating object in the user
interface, see the Codeworks Procedures Manual.  For more information
about the Glyphic Script language itself, see the Codeworks Scripting
Manual.
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